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บทที่ 4 

ผลการศึกษา 

 

4.1  ศึกษาฐานข้อมูล GIS ของพื้นที่ศึกษาที่มีอยู่แล้ว 

   จากการศึกษาฐานข้อมูล GIS ของพื้นที่ศึกษาที่มีอยู่แล้วและข้อมูลที่เกี่ยวข้อง เพื่อตรวจสอบ

สภาพของระบบระบายน้้าที่มีอยู่ในปัจจุบัน สภาพพื้นที่ชั้นความสูง ตลอดจนคัดเลือกพื้นที่ศึกษาที่มี

ปัญหาน้้าท่วมขังที่เหมาะสม องค์ประกอบของฐานข้อมูล GIS ของเทศบาลเมืองนครพิษณุโลกนั้น 

ประกอบไปด้วยข้อมูลด้านต่าง ๆ ดังรูปที่ 4.1 โดยมีรายละเอียดดังนี้  

   4.1.1   ข้อมูลเชิงพื้นท่ี เป็นข้อมูลในรูปแบบ Vector ประกอบด้วยชั้นข้อมูลต่าง ๆ  ดังนี้ 

  (1) Bridge Data เป็นชั้นข้อมูลที่น้าเสนอในรูปของขอบเขตพื้นที่ของสะพาน แสดงใน
ขอบเขตของพื้นที่ศึกษา 
  (2) Flood Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของขอบเขตพื้นที่น้้าท่วม แสดงใน
ขอบเขตของพื้นที่ศึกษา 
  (3) Hydrop Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของลุ่มน้้าแสดงในขอบเขตของ
พื้นที่ศึกษา 
  (4) Munisan Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบขอบเขตของเทศบาล พื้นที่ศึกษา : 
เทศบาลนครพิษณุโลก 
  (5) Road Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบเส้นทางคมนาคมแสดงในขอบเขตของ
พื้นที่ศึกษา 
  (6) Rail Data เป็นชั้นข้อมลูที่น้าเสนอในรูปแบบเส้นทางคมนาคมแสดงใน (ทางรถไฟ) 
ของพื้นที่ศึกษาขอบเขต 
  (7) Contour Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของเส้นความสูงเท่าของพื้นที่นั้น ๆ 
หรือก็คือเป็นการแสดงความสูงต่้าของลักษณะภูมิประเทศโดยสร้างเส้นสมมุติที่ให้เส้นนั้นลากผ่านจุด 
ใด ๆ ที่มีความสูงเท่ากัน 
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รูปท่ี 4.1 ระบบฐานข้อมูล GIS ของเทศบาลเมืองนครพิษณุโลก 

 

 4.1.2  ข้อมูลส่วนที่สามารถน้ามาประยุกต์ใช้ในการศึกษาการระบายน้้าชุมชน (Urban Drainage) 

เป็นส่วนองค์ประกอบของฐานข้อมูล GIS ของเทศบาลเมืองนครพิษณุโลก ที่สามารถน้ามาประยุกต์ใช้ใน

การศึกษาการระบายน้้าชุมชน (Urban Drainage) เพื่อวิเคราะห์หาพารามิเตอร์ทางอุทกวิทยาที่น้ามาใช้ใน

การออกแบบระบบระบายน้้า  ประกอบไปด้วยข้อมูลด้านต่าง ๆ ดังนี้  

          (1)  ข้อมูล Digital Elevation Model (DEM)   โดยมีรายละเอียดดังน้ี  

     (1.1)  Feature Layer ที่เป็นชุดของข้อมูลน้าเข้าหลัก ๆ คือ   

                            - Contour Data เป็นชั้นข้อมูลที่ น้าเสนอในรูปแบบของเส้นความสูงเท่าของ

พื้นที่ และในการก้าหนดค่าให้เลือกฟิลด์ที่บันทึกค่าความสูงของเส้น และ Type เป็น Contour 

                            - Boundary Data เป็นชั้นข้อมูลที่น้าเสนอข้อมูลในรูปแบบของพื้นที่รูปปิด 

(Polygon) ในที่นี้อาจเป็นชั้นข้อมูลของพื้นที่ศึกษา (Study Area) เพื่อน้ามาใช้แสดงเป็นขอบเขตของ

ผลลัพธ์ (Out put) เท่านั้น เพราะฉะนั้นจึงไม่ต้องมีการก้าหนดฟิลด์ ส่วน Type เลือกเป็น Boundary 
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  (1.2) Field ใช้ในการก้าหนดหรือเลือกฟิลด์ที่บันทึกข้อมูลที่เหมาะสมกับประเภทของ

ชั้นข้อมูล ที่ต้อง การจะสร้าง DEM 

  (1.3) Type ประเภทของชุดข้อมูลที่น้าเข้า เพื่อน้ามาใช้ในการสร้าง DEM จะประกอบไป

ด้วยข้อมูลเชิงพื้นที่ต่าง ๆ และข้อมูลที่จ้าเป็นในการน้าไปใช้สร้าง DEM คือ ข้อมูลระดับความสูง 

(Contour Data)  

      (2) ข้อมูลเชิงพื้นที่ อื่น ๆ  

  - Watershed Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของขอบเขตพื้นที่ลุ่มน้้า แสดงใน

ขอบเขตของพื้นที่ศึกษา 

  - Road Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบเส้นทางคมนาคม แสดงในขอบเขตของ

พื้นที่ศึกษา 

  - Rail Data เปน็ชั้นข้อมูลที่น้าเสนอในรูปแบบเส้นทางคมนาคม (เส้นทางรถไฟ) แสดง

ในขอบเขตของพื้นที่ศึกษา 

  - Land Use Data เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของลักษณะการใช้ที่ดินสามารถ

แยกประเภทต่าง ๆ เช่น เขตเมือง (พื้นที่อยู่อาศัย) เขตพื้นที่โครงสร้างพื้นฐาน (เส้นทางถนน เส้นทาง

รถไฟ) และ อื่น ๆ เป็นต้น 

4.2 ตรวจสอบข้อมูลภาคสนามที่ส้าคัญ  

   เพื่อให้สอดคล้องกับฐานข้อมูล GIS ที่มีอยู่ ตลอดจนข้อมูลที่จ้าเป็นเกี่ยวกับระบบระบายน้้า เมื่อ

ท้าการประเมินระบบ GIS ที่มีอยู่และท้าการเลือกพื้นที่ที่มีปัญหาการระบายน้้า ในเขตเทศบาลนคร

พิษณุโลก จากแผนที่ GIS แล้ว จึงท้าการส้ารวจภาคสนามเพื่อตรวจสอบสภาพพื้นที่จริง ลักษณะการใช้

ที่ดิน ท่อระยายน้้าในพื้นที่ ลักษณะการไหลของน้้า ตลอดจนสอบถามจากวิศวกรผู้ดูแลระบบระบายน้้าใน

พื้นที่ ถึงปัญหาการระบายน้้า และการออกแบบระบบระบายน้้าที่ต้องการ 

 จากพื้นที่ที่มีปัญหาการระบายน้้าจากแผนที่ GIS สรุปได้ว่ามีหลายพื้นที่ ดังแสดงด้วยพื้นที่สีฟ้า

ในรูปแผนที่ GIS รูปที่ 4.1 ข้างต้น แต่ละพื้นที่มีผลกระทบต่อทรัพย์สิน และความรุนแรงของปัญหา

เป็นไปตามลักษณะความส้าคัญของการใช้พื้นที่ เมื่อได้ตรวจสอบจากภาคสนาม และสอบถามความเห็น
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กับวิศวกรผู้ดูแลระบบระบายน้้าของเทศบาลนครพิษณุโลก ได้ข้อสรุปเลือกพื้นที่ศึกษาเป็นพื้นที่ที่ประสบ

ปัญหาการระบายน้้าในบริเวณถนนราเมศวรเพื่อใช้ในการศึกษาประยุกต์  ข้อมูล GIS เพื่อการระบายน้้า 

ดังรูปที่ 4.2 จากนั้นจึงท้าการประเมินลักษณะของการใช้พื้นที่ ซึ่งสามารถท้าการส้ารวจจากข้อมูล

ภาคสนามโดยตรง เพื่อวัดพื้นที่ของแต่ละประเภทในการใช้ประโยชน์ที่ดิน  แต่เน่ืองจากในการวิจัยนี้

อาศัยการวิเคราะห์บนระบบแผนที่ GIS จึงท้าการประเมินข้อมูล Land Use ประเภทต่างๆ ในบริเวณพื้นที่

รับน้้า (Watershed) ที่ศึกษาโดยการ Digitizing อ้างอิงจากภาพถ่ายดาวเทียมรายละเอียดสูง QuickBird ดัง

รูปที่ 4.3   และ overlay  ลงบนแผนที่ GIS  ท้าให้สามารถหาพื้นที่ของ Land use แต่ละประเภทได้ แต่

อย่างไรก็ตาม จ้าเป็นต้องท้าการตรวจสอบความถูกต้องของประเภท Land use จากภาพถ่ายดาวเทียมกับ

ของจริง โดยรายละเอียดแนวทางการด้าเนินงานแสดงในหัวข้อการวิเคราะห์ข้อมูล 

 

รูปท่ี 4.2 ประยุกต์ ข้อมูล GIS เพื่อการระบายน้้า ของพื้นที่ศึกษาในเขตเทศบาลเมืองนครพิษณุโลก 
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รูปท่ี 4.3  ข้อมูลภาพถ่ายดาวเทียมรายละเอียดสูง QuickBird บริเวณพื้นที่ศึกษาถนนราเมศวร 

4.3  งานวิเคราะห์ข้อมูลด้วยฐานข้อมูล GIS  

    เมื่อท้าการส้ารวจสภาพระบบระบายน้้าที่มีอยู่ในปัจจุบัน สภาพปัญหาน้้าท่วมขังในพื้นที่และ 

ขีดจ้ากัดของพื้นที่ เพื่อประเมินปัญหาการเกิดน้้าท่วม และด้าเนินการเลือกพื้นที่ศึกษาที่เหมาะสมแล้ว จึง

ท้าการวิเคราะห์ทางอุทกวิทยา ภายใต้ แบบจ้าลอง GIS ในการวิจัยนี้ได้ท้าการวิเคราะห์แนวทางการใช้งาน

แบบจ้าลองทาง GIS ที่สามารถรองรับการวิเคราะห์ทางอุทกวิทยา อันประกอบด้วย การใช้พื้นที่ การสร้าง

ขอบเขตพื้นที่ระบายน้้า (watershed) ทิศทางการไหลของน้้า (Flow direction) ตลอดจนการวัดพื้นที่และ

ความลาดชัน  เพื่อให้สามารถวิเคราะห์ข้อมูลทางอุทกวิทยาที่ต้องใช้ในการออกแบบระบบระบายน้้าได้ 

โดยในการวิเคราะห์จะอาศัยกล่องเคร่ืองมือที่มีอยู่ในแบบจ้าลองภูมิสารสนเทศ ArcGIS ซึ่งเป็นโปรแกรม 

GIS ที่นิยมใช้กันในหน่วยงานต่างๆ  ในขั้นตอนนี้จะต้องอาศัยฐานข้อมูล GIS ที่ประกอบไปด้วย

ข้อมูลที่จ้าเป็นต่อการน้าไปวิเคราะห์ มีดังต่อไปนี้ 
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(1)  ข้อมูล DEM 

- Feature Layer ที่เป็นชุดของข้อมูลน้าเข้าหลัก ๆ คือ  

 Contour เป็นชั้นข้อมูลที่น้าเสนอในรูปของเส้นความสูงเท่าของพื้นที่ ในการ

ก้าหนดค่าให้เลือกฟิลด์ที่บันทึกค่าความสูงของเส้น และ Type เป็น Contour 

 Boundary เป็นชั้นข้อมูลที่น้าเสนอข้อมูลในรูปของพื้นที่รูปปิด (Polygon) ใน

ที่นี้อาจเป็นชั้นข้อมูลของพื้นที่ศึกษา (Study Area) เพื่อน้ามาใช้แสดงขอบเขตของ

ผลลัพธ์ (Out put) เท่านั้น เพราะฉะนั้นจึงไม่ต้องมีการก้าหนดฟิลด์ ส่วน Type เลือกเป็น 

Boundary 

        - Field ใช้ในการก้าหนดหรือเลือกฟิลด์ที่บันทึกข้อมูลที่เหมาะสมกับประเภทของชั้นข้อมูล 
ที่ต้อง การจะสร้าง DEM 
        - Type ประเภทของชุดข้อมูลที่น้าเข้า เพื่อน้ามาใช้ในการสร้าง DEM จะประกอบไปด้วย
ข้อมูลเชิงพื้นที่ต่าง ๆ และข้อมูลที่จ้าเป็นในการน้าไปใช้สร้าง DEM คือ ข้อมูลระดับความสูง (Contour) 
 

(2)  ข้อมูลเชิงพื้นท่ี อื่น ๆ   

         -  Watershed เป็นชั้นข้อมูลที่น้าเสนอในรูปของ ขอบเขตพื้นที่ลุ่มน้้า แสดงในขอบเขตของ

พื้นที่ศึกษา 

       -    Road เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบเส้นทางคมนาคมแสดงในขอบเขตของพื้นที่ 

ศึกษา 

       -  Rail Line เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบเส้นทางรถไฟแสดงในขอบเขตของพื้นที่ 

ศึกษา 

- Land Use เป็นชั้นข้อมูลที่น้าเสนอในรูปของลักษณะการใช้ที่ดินประเภทต่าง ๆ เช่น  

เขตเมือง (พื้นที่อยู่อาศัย) เขตพื้นที่โครงสร้างพื้นฐาน (ถนน เส้นทางรถไฟ) และ อื่น ๆ เป็นต้น ซึ่งข้อมูล  

Land Use ที่ใช้ในการศึกษา Watershed นี้ได้จากการ Digitizing   

    การใช้งานแบบจ้าลอง ArcGIS เพื่อวิเคราะห์ทางอุทกวิทยามี 4 ส่วนที่ส้าคัญ ดังนี้ 
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4.3.1 การวิเคราะห์พื้นท่ีรองรับน้้า (Watershed) 

ในการวิเคราะห์พื้นที่รองรับน้้า (Watershed) ต้องใช้ชั้นข้อมูล DEM (DIGITAL ELEVATION 

MODEL) เพื่อช่วยสนับสนุนในการวิเคราะห์ ส้าหรับข้อมูลที่จะน้ามาใช้ในการสร้างชุดของข้อมูล DEM 

นั้นจะประกอบไปด้วยข้อมูลต่าง ๆ เช่น ชั้นข้อมูลจุดความสูง (Spot elevation), ชั้นข้อมูลเส้นความสูง 

(Contour), ชั้นข้อมูล Stream, ชั้นข้อมูล Boundary (ในที่นี้อาจเป็นชั้นข้อมูลขอบเขตของจังหวัด หรือ

ขอบเขตของ Study Area) ชั้นข้อมูลที่จ้าเป็นในการน้าเข้าหลัก ที่ส้าคัญ คือ ชั้นข้อมูลเส้นความสูง 

(Contour) เป็นชั้นข้อมูลที่น้าเสนอในรูปแบบของเส้นความสูงเท่าของพื้นที่ ส่วนชั้นข้อมูลอื่น ๆ นั้น

น้ามาใช้ประกอบเพื่อท้าให้ชั้นข้อมูล DEM ที่สร้างขั้นมาแล้วนั้นให้มีความสมบูรณ์มากขึ้น โดยที่ใน

การศึกษาคร้ังนี้จะวิธีการสร้างพื้นผิวในรูปแบบของ TIN  เพื่อน้ามาใช้เป็นข้อมูลตั้งต้นในการสร้างชั้น

ข้อมูล DEM   รายละเอียดขั้นตอนการด้าเนินการวิเคราะห์พื้นที่รองรับน้้า (Watershed) มีดังนี้ 

 (1) การสร้างพื้นผิวในรูปแบบ TIN จากข้อมูลพื้นที่ 2 มิติ 

 ในการสร้างพื้นผิวในรูปแบบ TIN ขากข้อมูล contour ที่เป็นข้อมูลเชิงพื้นที่ 2 มิตมิีขั้นตอนดังนี้ 

 เปิดโปรแกรม Arc Map  และน้าเข้าข้อมูล โดยคลิกที่ปุ่ม  Add Data    

 น้าเข้าข้อมูลจากฐานข้อมูลที่ต้องการ โดยเลือกข้อมูล contour_1.shp เพื่อแสดงเส้นชั้นความ

สูงของ Study Area ดังรูป 
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 ท้าการสร้าง TIN โดยคลิกที่เมนู 3D Analyst > Create/Modify TIN > Create TIN from 

Features… ดังรูป 

 

 

 

 

 

 

 

 ชั้นข้อมูล Contour  ก้าหนดดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

 ที่ Output TIN: ก้าหนดที่เก็บผลลัพธ์ และคลิกปุ่ม OK  

 จะได้ผลลัพธ์เป็นข้อมูล TIN ที่แสดงความสูงของพื้นที่ ตามขอบเขตพื้นที่ Study Area ที่ใช้

เป็นขอบเขตในการสร้างข้อมูล  ดังรูป 
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 ท้าการเปลี่ยนชั้นข้อมูล TIN ที่ได้สร้างขึ้นมาให้เป็นชั้นข้อมูล DEM โดยคลิกที่เมนู 3D 

Analyst > Convert > TIN to Raster… ดังรูป 

 

 

 

 

 

 

 

  

  
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 ก้าหนดค่าและคลิกปุ่ม OK ดังรูป 

 

 

 

 

 

     

 

 จะได้ข้อมูล DEM ดังรูป ซึ่งสามารถน้าไปใช้ในการวิเคราะห์แบบจ้าลองทางอุทกศาสตร์ 

(Hydrology Model Analysis)  
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 (2)   การเติมเต็มพื้นที่(Fill) เพื่อวิเคราะห์ด้วยชุดค้าสั่งทางอุทกวิทยา  

                     (Hydrology Model Analysis) 

       ในโปรแกรม ArcGIS มี Extension ชื่อ Spatial Analyst ที่มีชุดค้าสั่งสนับสนุนการวิเคราะห์

ข้อมูลอุทกศาสตร์ซึ่งอยู่ในส่วนของ Hydrology ซึ่งผู้ใช้งานสามารถประยุกต์ใช้ในการวิเคราะห์การไหล

ของน้้าในพื้นที่ลุ่มน้้า  ขั้นตอนการวิเคราะห์ข้อมูลอุทกศาสตร์ด้วยระบบสารสนเทศภูมิศาสตร์ มีดังนี้ 

 เปิดโปรแกรม ArcMap 

 เปิดใช้งาน Spatial Analyst โดยคลิกเมนู Tools > Extensions > คลิกในกล่องสี่เหลี่ยมหน้า 

Spatial Analyst และปิดหน้าต่าง ดังรูป  

 

 

  
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 การเติมเต็มพื้นที่ (Fill) เป็นค้าสั่งเพื่อการเติมพื้นที่บริเวณที่เป็นหลุมหรือต่้ากว่าบริเวณ

ทั่วไป และหากบริเวณใดมีความสูงกว่าพื้นที่ทั่วไปจะลดให้ใกล้เคียงพื้นที่นั้น ๆ เพื่อให้

การไหลของน้้าเป็นไปได้อย่างต่อเนื่อง ดังนี้  

  -น้าเข้าข้อมูล DEM จากโฟลเดอร์ที่ Save เก็บไว้ 

  -เปิด ArcToolbox ดับเบิ้ลคลิกที่ Spatial Analyst Tools > Hydrology > Fill  

ดังรูป 
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-น้าข้อมูล DEM มาท้าการเติมเต็มพื้นที่ ในหน้าต่าง Fill กา้หนดค่าและคลิกปุ่ม 

OK   ดังรูป 
                                                                                                 
 

 

  

 

 

 

 

 

-เมื่อประมวลผลเสร็จแล้วปิดหน้าต่าง โดยคลิกปุ่ม Close 

-ผลลัพธ์จะได้ข้อมูล DEM ที่ท้าการ Fill แล้ว ดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

เลือกข้อมูล Raster ที่

ต้องการ Fill 

เลือกที่เก็บและตั้งชื่อผลลัพธ์ 

ข้อมูล Raster 



ระบบจัดการการระบายน้้าชุมชนโดยข้อมูลภูมิสารสนเทศ                                                                                          4-14 
 

 (3)  การวิเคราะห์ทิศทางการไหล (Flow Direction)  

       เป็นขั้นตอนในการน้าข้อมูลที่ผ่านการ Fill มาวิเคราะห์ ทิศทางการไหลของน้้า (Flow 

Direction)ผลลัพธ์ที่ได้จะแสดงเป็นตัวเลข Direction Code ที่จะบ่งบอกทิศทางการไหล โดยมีขั้นตอน

ดังนี ้ 

 ดับเบิ้ลคลิกที่เคร่ืองมือ Flow Direction  

 

 

 

 

 

 

 

 

 

 

 

 หน้าต่าง Flow Direction ก้าหนดค่า และคลิกปุ่ม OK 

 
                                                                                    
         

 

 

 

                                                                           

                                                                                                                                                                                       

   เลือกที่เก็บและตั้งชื่อ 
   ผลลัพธ์ข้อมูล 

เลือกข้อมูลที่ Fillมาแล้ว 
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 เมื่อประมวลผลเสร็จแล้วปิดหน้าต่าง โดยคลิกปุ่ม Close 

 ผลลัพธ์จะแสดงค่ารหัสตัวเลขซึ่งจะแทนด้วยทิศทางการไหลของน้้าว่าจะไหลไป 

ทางไหนดังรูป 

 

 

 

 

 

 

 

 

 

 

 

  

 (4)  การวิเคราะห์การไหลสะสม (Flow Accumulation) 

      Flow Accumulation คือหาค่าการไหลสะสมของข้อมูลทุก ๆ เซล เพื่อดูแนวทางการไหล

สะสมของลุ่มน้้า และสามารถประยุกต์หาพื้นที่ลุ่มน้้าหรือทางไหลออกของน้้า (Outlet) มีขั้นตอน

ด้าเนินการดังนี้ 
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 ดับเบิ้ลคลิกค้าสั่ง Flow Accumulation ดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

 หน้าต่าง Flow Accumulation ก้าหนดค่าและคลิกปุ่ม OK ดังรูป 
 

                                                                                                 
 

ก้าหนดข้อมูล  Flow 

Direction 

                                                                                                 

ก้าหนดทีเ่ก็บและตัง้ชื่อ  

 ผลลัพธ์ 
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 เมือ่ประมวลผลเสร็จแล้วปิดหน้าต่าง โดยคลิกปุ่ม Close 

 ผลลัพธ์ Flow Accumulation ดังรูป  

 

 

 

 

 

 

 

 

 

 

 

  

 (5)  การสร้าง Watershed  

       ในโปรแกรม ArcGIS ก้าหนดวิธีการสร้าง Watershed ต้องก้าหนดให้มี Pour Point คือจุดที่

เราจะสร้างฝายชะลอน้้า และ Flow Direct ที่จะเป็นข้อมูล Input ดังนั้นจะท้าการสร้าง Pour Point ดังนี้  

 สร้างชั้นข้อมูลใหม่ให้ชื่อ Pour Point โดยดับเบิ้ลคลิก Data Management Tools > 

Feature Class > Create Feature Class ดังรูป 
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 หน้าต่าง Create Feature Class  ก้าหนดค่าและคลิกปุ่ม OK 
                                                                                    
            

          

         

 

 

 

 

 

 

 

 

 

 

 

 

 

ก้าหนดโฟลเดอรท์ี่เกบ็ข้อมูล                                                                                           

ตั้งชื่อช้ันข้อมูล                                                                                                

เลือกประเภทข้อมูลที่ต้องการ 
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  เมื่อประมวลผลเสร็จปิดหน้าต่าง โดยคลิกปุ่ม Close 

 เปิดแถบเคร่ืองมือ Editor โดยคลิกปุ่ม  

คลิก Editor > Start Editing ที่ Target เป็น  Pour Point และ Task เป็น Create New 

Feature  ดังรูป 

 

 

 แสดงเฉพาะชั้นข้อมูล Flow Acc_Flow , Road_Ramesuan และ  Pour Point 
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 น้าเข้าจุด Pour Point โดย คลิกปุ่ม                

 และคลิกต้าแหน่ง  ดังภาพ (สมมติเป็นจุด Outlet) 

 

 

 

 

 

 

 

 

 

 

 ใช้ค้าสั่ง Snap Point เพื่อใช้ในการเชื่อมต่อจุดที่ท้า Pour Point กับ Accumulation 
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 หน้าต่าง Snap Pour Point ก้าหนดค่าและคลิกปุ่ม OK 

 
                                                                              
 

ก้าหนดช้ันข้อมูล Pour Point 

 

เลือก Flow Accumulation 

                                                                          

                                                                         เลือกที่เก็บและตั้งชื่อผลลัพธ์ 

 

 

 

 

 จะปรากฏภาพดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 



ระบบจัดการการระบายน้้าชุมชนโดยข้อมูลภูมิสารสนเทศ                                                                                          4-22 
 

 ท้าการสร้าง Watershed โดยดับเบิ้ลคลิกค้าสั่ง Watershed 

 

 

 

 

 

 

 

 

 

 

 

 

 หน้าต่าง Watershed ก้าหนดค่า และคลิกปุ่ม OK ดังรูป 

 

 

 
เลือก Flow Direction 

 

เลือกข้อมูล Snap Pour point                                                      
                                                      

                                                     เลือกที่เก็บและตั้งชื่อผลลัพธ์ 
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 จะได้ผลดังรูป บริเวณที่เป็นสีม่วง คือบริเวณที่รับน้้า (Watershed) ซึ่งไหลไปยังจุด  

   Pour point หรือจุด Outlet ที่ก้าหนดขึ้น 

 

 

 

 

 

 

 

 

 

 

 

 

  ท้าการแปลงข้อมูล Watershed เป็นข้อมูลเชิงพื้นที่ โดยดับเบิ้ลคลิกบน Conversion  

   Tools > From Raster > Raster to Polygon 
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 หน้าต่าง Raster to Polygon ก้าหนดค่า และคลิกปุ่ม OK ดังรูป                                             
 

 

เลือกข้อมูล Raster ที่

ต้องการแปลง 

 

                                          

เลือกที่เก็บและตั้งชื่อ

ผลลัพธ์  

 

 

 

 เมื่อประมวลผลเสร็จปิดหน้าต่าง โดยคลิกปุ่ม Close 

 จะปรากฏชั้นข้อมูล Watershed ดังรูป 
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    4.3.2 การประเมิน Land Use ด้วยการ Digitizing  

 การดิจิไทซ์ (Digitizing)   เป็นการคัดลอกลายจากข้อมูลต้นฉบับ เช่น ข้อมูลภาพถ่ายจาก
ดาวเทียม ภาพถ่ายทางอากาศ แผนที่ภูมิประเทศ เป็นต้น ซึ่งข้อมูลเหล่านี้เป็นข้อมูลชนิด Raster ให้อยู่ใน

ระบบข้อมูลชนิด Vector ในรูปแบบจุด เส้น หรือพื้นที่ ด้วยระบบคอมพิวเตอร์และอุปกรณ์ต่อพ่วง โดยที่
การดิจิไทซ์ (Digitizing)  ข้อมูลนั้น สามารถท้าได้ในโปรแกรม ArcMap ซึ่งจะมีเคร่ืองมือส้าหรับใช้งาน
ต่าง ๆ มากมาย ที่จะช่วยเพิ่มประสิทธิภาพการท้างานให้สะดวกและรวดเร็วยิ่งขึ้น และการน้าเข้าข้อมูล
ด้วยวิธีการดิจิไทซ์ (Digitizing)  นั้นจะต้องท้าในระบบพิกัดภูมิศาสตร์เดียวกัน โดยการดิจิไทซ์ 
(Digitizing) ข้อมูล Land  Use มีขั้นตอนดังนี้ 
 

(1) ให้ท้าการน้าเข้าข้อมูลภาพถ่ายดาวเทียม QuickBird11 โดยคลิกที่ปุ่ม Add Data  

                 เพื่ออาศัยข้อมูลนี้เป็นแผนที่ฐาน 

* หมายเหตุ: ข้อมูลภาพถ่ายดาวเทียม QuickBird11 ที่น้ามาใช้ ได้ท้าการปรับแก้พิกัดแล้ว 

 (2) น้าเข้าข้อมูล [shape file] ต่าง ๆ ดังนี้  

- Watershed 

- Ramesuan (ข้อมูลขอบเขตเทศบาลนครพิษณุโลก) ซึ่งเป็น Study Area   

 โดยให้คลิกที่ปุ่ม Add Data            ดังรูป 

  

 

 

 

 

 

 

 

 

 

Study Area 

Watershed 
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 (3)   ท้าการ Snap ข้อมูล land_use ตามดังต่อไปนี้  

  - ก้าหนด Snapping Environment  

ก่อนการสร้างและแก้ไขข้อมูล ควรก้าหนด Snapping Environment เพื่อช่วย 

แก้ปัญหา ในเร่ืองการเชื่อมต่อกันระหว่างฟีเจอร์ ตัวอย่างเช่น การแก้ไขรูปร่างของพื้นที่ ที่น้าเข้า

ไปอาจเชื่อมต่อกันไม่สนิท ท้าให้ต้องมาแก้ไขในภายหลัง ดังนั้นโปรแกรม ArcMap มีเคร่ืองมือที่

จะช่วยแก้ปัญหานี้ได้ โดยสามารถก้าหนดค่าการเชื่อมต่อกันให้สนิทด้วย Snapping Environment  

- ก้าหนด Snapping tolerance 

ก้าหนดค่าระยะห่าง Node ของเส้นหนึ่งเชื่อมต่อเข้ากับ Node หรือ Vertex ของ

อีกเส้นหน่ึง โดยอัตโนมัติภายในระยะห่างที่ตั้งค่าไว้ (Tolerance) จะต้องมีการก้าหนดค่า

ระยะห่างนี้ต้ังแต่ก่อนเร่ิมท้าการน้าเข้าข้อมูล           

 Add data                               land_use  ซึ่งเป็น shapefile ที่สร้างใหม่ 

 เปิดแถบเคร่ืองมือ Editor โดนคลิกที่ปุ่ม Editor บนแถบเคร่ืองมือ หรือ

คลิกที่เมนู View    >    Toolbar    >   Editor  

 

 

 เร่ิมการแก้ไข โดยคลิกที่ Editor เลือก Start Editing 

 

 

 

 

 

 

 

 คลิก Editor เลือก Options คลิก General Tab ที่ Snapping tolerance: 

พิมพ์ค่าที่ต้องการ เช่น 7 สามารถเลือกหน่วยได้จาก Dropdown Arrow 

และคลิกปุ่ม OK. ดังรูป 
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  - ก้าหนด Snapping Properties 

ควบคุมการแก้ไขส่วนที่เชื่อมต่อกัน โดยก้าหนดส่วนของข้อมูลที่จะเชื่อมต่อ

ใหม่นี้ให้ Snap กับส่วนใดของข้อมูลเดิม เช่น Snap ที่จุดหักเห (Vertex) , ขอบ (Edge) , จุดปลาย 

(End) 

คุณสมบัติการ Snap ของชั้นข้อมูล (Layer Snapping Properties) สามารถ

ก้าหนด Snap ภายในชั้นข้อมูลเดียวกัน เช่น ก้าหนด Snap เส้นถนนทุก ๆ เส้นให้เชื่อมต่อกัน หรือ

ระหว่างชั้นข้อมูลก็ได้  
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                                          จุดหักเห (Vertex)               ขอบ (Edge)                 จุดปลาย (End) 

 

 

 

 

คุณสมบัติการ Snap ของ Sketch สามารถก้าหนด Snap ขณะที่ก้าลังวาดข้อมูล โดยสามารถ

เลือก Snap ที่จุดหักเห ขอบ หรือสร้าง Sketch ให้ตั้งฉาก 

 
                                                                                                   Edit sketch vertices                 ก้าหนดให้เชื่อมต่อไปยังจุด Vertex  

                                                                                                                   ในขณะก้าลังวาดข้อมูล 

                                                  

                                                  Edit sketch edges                   ก้าหนดใหเ้ชื่อมต่อไปยงัขอบ  

                                                                                                  ในขณะก้าลังวาดข้อมูล 

 

                                                  Perpendicular to sketch           ก้าหนดให้วาดตั้งฉาก 

                                                                                                   ในขณะก้าลังวาดข้อมูล 

                        

 

 

 (4)  เร่ิมการแก้ไข โดยคลิก Editor เลือก Start Editing 

 (5) คลิก Editor เลือก Snapping จะปรากฏหน้าต่าง Snapping Environment สามารถเลือก 

(Check) หรือ ไม่เลือก (Uncheck) ชั้นข้อมูลที่ต้องการให้ Snap ที่จุดหักเห (Vertex), ขอบ (Edge) หรือ จุด

ปลาย (End) ของข้อมูลได้ เช่น ถ้าต้องการสร้างให้มีเส้นต่อเน่ืองกัน ให้คลิกเลือก Snap ทุกอัน 
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 (6) เร่ิมท้าการดิจิไทซ์ (Digitizing) โดยคลิกที่ Editor    >    Start Editing 

 

 

 

 

 

 

 

 

 

 

 

 

 

 (7) Task : เลือกลักษณะงานที่ต้องการ ซึ่งชั้นข้อมูลใหม่นี้ยังไม่มีข้อมูลใดๆ จึงให้เลือก Task 

เป็น Create New Feature 

 



ระบบจัดการการระบายน้้าชุมชนโดยข้อมูลภูมิสารสนเทศ                                                                                          4-30 
 

 

 (8) Target : เลือกชั้นข้อมูลที่จะสร้างข้อมูลใหม่เป็น land_use 

 

 

 (9) ท้าการก้าหนด Snapping เพื่อเชื่อมต่อข้อมูลได้อย่างสะดวก รวดเร็ว และมีความถูกต้องใน

การวาด (Sketch) 

 (10) คลิก Sketch tools         เพื่อท้าการ Sketch  ข้อมูล ใช้เมาส์คลิกที่จุดเร่ิมต้นของต้าแหน่งที่

ต้องการ และคลิกต้าแหน่งใด ๆ ต่อไปเร่ือย ๆ เมื่อต้องการสิ้นสุดการสร้างข้อมูลหรือการดิจิไทซ์ 

(Digitizing) ให้ดับเบิ้ลคลิก ณ จุดสิ้นสุดนั้น หรือคลิกขวาแล้วเลือก Finish Sketch หรือ กดปุ่ม F2 บน

คีย์บอร์ด 

 (11) จากนั้นก็ใส่ข้อมูลในตาราง Attributes จ้าแนกการใช้ประโยชน์ที่ดิน Land use ออกเป็น 

Urban Built - Up Land [พื้นที่อยู่อาศัย] Transportation  [ถนนราเมศวร] Barren Land [soil] ที่ว่างข้างทาง

รถไฟ Transportation [ถนนเลียบทางรถไฟฝั่งตะวันตก] Urban Land [ ส้านักงาน ธนารักษ์จังหวัด] 

 (12) ผลลัพธ์ที่ได้เป็นข้อมูล land_use จ้าแนกในขอบเขตพื้นที่ Study Area ที่ใช้เป็นฐานข้อมูล

ของจังหวัดพิษณุโลก ดังรูป 
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            4.3.3 การหาพื้นท่ี ของพื้นท่ีลุ่มน้้า (Watershed) 

         เมื่อท้าการ จ้าแนก land use เสร็จแล้ว จะสามารถค้านวณหาขนาดของพื้นที่ได้ในแต่ละ 
zone ได้ 2 วิธี คือ 

        (1) วิธีการค้านวณพื้นที่แบบ Advanced เป็นการค้านวณพื้นที่ โดยการเขียน Script ของ 
Visual Basic for Application (VBA) มีวิธีการดังนี้ 

 คลิกขวาที่ชื่อของ Layer นั้นแล้วเลือก Open Attribute table 

 คลิกที่ปุ่ม Option แล้วเลือก Add field ดังรูป 

 

 

 

 

 

 

 

 

 ที่หน้าต่าง Add field ตั้งชื่อ Field ที่ช่อง Name และเลือก Type เป็น Double ไม่ต้อง

เปลี่ยนแปลงค่า Precision และ Scale 
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 คลิกขวาที่ Field นั้น เลือก Field Calculator ดังรูป 

 

 

 

 

 

 

 

 

 

 

 จะมีหน้าต่างเตือนขึ้นมาเน่ืองจากยังไม่ได้ท้าการ Start Edit ซึ่งจะท้างานได้รวดเร็ว

กว่าการสั่ง Start Edit ก่อน แต่มีข้อเสียคือไม่สามารถ Undo ได้ ถ้าต้องการ

เปลี่ยนแปลงต้องท้ากระบวนการนั้นใหม่ ให้กด Yes 

 ที่หน้าต่าง Field Calculator  ให้ Check box หน้า Advanced เพื่อใช้ความสามารถ

ของ Visual Basic for Application (VBA) 
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 จะเห็นได้ว่าหน้าต่างของ Statement เพิ่มขึ้นเป็นสองส่วน คือ Pre-Logic VBA Script 

Code ซึ่งใช้ในการเขียน Script ของ Visual Basic และสว่นที่เป็น ชื่อ Field เช่นใน

ตัวอย่าง เป็น Area = เป็นช่องที่ใช้ใส่ตัวแปรที่ต้องการให้เป็น Output 

 จากตัวอย่างนี้ จะค้านวณหาพื้นที่ โดยสามารถคัดลอก Script ได้โดยกดปุ่ม Help 

เลื่อนหา To calculate area จากนั้นก็คัดลอกมาวางในช่อง Pre-Logic VBA Script 

Code ส่วนช่องล่างสุดใส่ output 
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 จากนั้นกด OK จะได้ผลลัพธอ์อกมาดังรูป 

 

* หมายเหตุ :  - หน่วยของข้อมูลจะเป็นหน่วยตามระบบพิกัด เช่น หากเป็นระบบ UTM )ที่ใช้ใน
ตัวอย่างนี้ (หน่วยจะเป็น เมตร หรือตารางเมตร หากผู้ใช้ต้องท้าการเปลี่ยนแปลงหน่วยเป็นไร่ หรือ ตาราง

กิโลเมตร ต้องท้าการแก้ไขอีกครั้ง  
  - การค้านวณดังกล่าวหากไม่มีการ Select record ใดเอาไว้ โปรแกรมก็จะท้าการค้านวณ
ให้ทุก ๆ เรคอร์ด ในฟิลด์นั้น แต่หากมีการ Select record ก็จะค้านวณเฉพาะ เรคอร์ดที่เลือกเท่านั้น 
  - การค้านวณพื้นที่เป็นตารางกิโลเมตร = พื้นที่ )หน่วยเมตร /( 1,000,000 
  - การค้านวณพื้นที่เป็นไร่ = พื้นที่ )หน่วยเมตร /( 1,600    

 

 นอกจากนี้ยังสามารถค้านวณค่าอ่ืนๆ ได้โดย Pre-Logic VBA Script Code ตาม 

ตารางที่ 4.1 
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           ตารางท่ี 4.1 การ ค้านวณค่าต่างๆโดย ใช้ Pre-Logic VBA Script Code  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Feature Type Parameter Field = Pre-Logic VBA Script Code 
Polygon พื้นที ่ dblArea Dim dblArea as double 

Dim pArea as IArea 
Set pArea = [shape] 
dblArea = pArea.area 

เส้นรอบวง dblPerimeter Dim dblPerimeter as double 
Dim pCurve as ICurve 
Set pCurve = [shape] 
dblPerimeter = pCurve.Length 

ค่าพิกดั X จุด
กึ่งกลางรูปปิด
หลายเหลี่ยม 

dblX Dim dblX As Double 
Dim pArea As IArea 
Set pArea = [Shape] 
dblX = pArea.Centroid.X 

ค่าพิกัด Y จุด
กึ่งกลางรูปปิด
หลายเหลี่ยม 

dblY Dim dblY As Double 
Dim pArea As IArea 
Set pArea = [Shape] 
dblY = pArea.Centroid.Y 

Line ความยาว dblLength Dim dblLength as double 
Dim pCurve as ICurve 
Set pCurve = [shape] 
dblLength = pCurve.Length 

Point ค่าพิกัด X dblX Dim dblX As Double 
Dim pPoint As IPoint 
Set pPoint = [Shape] 
dblX = pPoint.X 

ค่าพิกัด Y dblY dblY = pPoint.Y  
Dim dblY As Double 
Dim pPoint As IPoint 
Set pPoint = [Shape]  
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          (2) วิธีการค้านวณพื้นที่ ด้วยค้าสั่ง Calculate Geometry โดยวิธีการน้ี  สามารถท้าได้ใน 

ArcGIS ตั้งแต่เวอร์ชั่น 9.2 ขึ้นไป และการค้านวณพื้นที่ด้วยวิธีการนี้สามารถเลือกหน่วยผลลัพธ์ที่ต้องการ

ได้ สามารถก้าหนดฟิลด์ได้ ทั้งในประเภทตัวเลขหรือตัวอักษร ถ้าก้าหนดฟิลด์เป็นประเภทตัวอักษร จะ

สามารถใส่ค้าย่อหน่วยได้ด้วย หากก้าหนดประเภทฟิลด์ที่เป็นตัวเลข ก็ควรก้าหนดชนิดของข้อมูลเป็น 

“Double” เน่ืองจากค่าที่ได้จากการค้านวณจะเป็นเลขทศนิยม ถ้าก้าหนดเป็น Integer ผลลัพธ์ที่จะปัดเศษ

ทศนิยม ท้าให้ผลลัพธ์คลาดเคลื่อนได้ และมีวิธีการค้านวณดังนี้ 

 คลิกขวาบนชั้นข้อมูล land_use เลือก Open Attribute Table 

 สร้างฟิลด์ใหม่เพื่อเก็บค่าพื้นที่หน่วยเป็นตารางกิโลเมตร โดยคลิกที่ปุ่ม Open  

แล้วเลือก Add Field  

 ตั้งชื่อฟิลด์ที่ช่อง Name เป็น Area_KM เลือก Type เป็น Double และคลิกปุ่ม OK 
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   คลิกขวาบนฟิลด์ Area_KM เลือก Calculate Geometry ดังภาพ 

 

 

 

 

 

 

 

 

 

 หน้าต่าง Calculate Geometry ก้าหนดค่าดังภาพและคลิกปุ่ม OK 

 

 

                                                                      
       

  

                                                                      
 

                                                                       เลือกหน่วยที่ใช้ในการค้านวณ  

 

 

 

 

 

 

 

    เลือกคุณสมบัติที่ต้องการค้านวณ 

เลือกใช้ระบบพิกัดเดียวกับข้อมูล 

เลือกระบบพิกัดของกรอบ 

ข้อมูล (Data Frame) 

ข้

อ

มู

ล

 

(

D

a

t

a

 

F

r

a
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 จะได้ผลดังภาพ 

 

 

 

 

 

 

 

 

 

 

 ก้าหนดให้ใส่ค่าหน่วยย่อในฟิลด์ด้วย โดยท้าการ Add Field อีกครั้ง ตั้งชื่อฟิลด์เป็น 

Area_Meter ก้าหนดประเภทฟิลด์เป็น Text ขนาด 20 ตัวอักษร 
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 คลิกขวาบนฟิลด์ Area_Meter เลือก Calculate Geometry เลือก Property: เป็น Area 

เลือก Units: เป็น Square Meters [sq m] และคลิก Add unit abbreviation to text field 

คลิกปุ่ม OK 
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 เมื่อพิจารณาจากผลที่ได้จากการค้านวณพื้นที่ทั้ง 2 วิธี นั้น พบว่าค่าที่ได้มีค่าใกล้คียงกันดังแสดง

ตารางเปรียบเทียบดังรูป 

                                                                                                                  วิธีท่ี 1                    วิธีท่ี 2 

 

 

 

 

 

 

 

    ผลจาการวิเคราะห์จะได้พื้นที่ในหน่วย ตารางเมตร ถ้าต้องการแปลงให้อยู่ในระบบ หน่วยไร่ก็

สามารถน้าค่าฟิลด์ Area มาหารด้วย 1,600 ได้ดังนี้ 

 สร้างฟิลด์ใหม่ โดยการคลิกปุ๋ม Options > Add Field  

 ที่หน้าต่าง Add Field ก้าหนดค่าดังภาพและคลิกปุ่ม OK  
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 คลิกขวาบนฟิลด์ Area_Rai เลือก Field Calcultor 
  

 

 

 

 

 

  ที่หน้าต่าง Field Calculator ในช่องของ Fields : ให้ดับเบิ้ลคลิก Area   ต่อจากนั้น

คลิกปุ่มเคร่ืองหมาย  /และพิมพ์ 1600 ในช่อง Area_Rai = จะปรากฏข้อความเป็น 

[Area]/1600 ดังภาพ จากนั้นคลิก OK 

 

 

 

 

 

 

 

 

* ถ้าต้องการค้านวณทุกเรคอร์ดให้คลิกเคร่ืองหมายถูกออก แต่ถ้าต้องการค้านวณ

เฉพาะเรคอร์ดที่ถูกเลือกเท่านั้นให้คงเคร่ืองหมายถูกเอาไว้ 
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  - โปรแกรมจะค้านวณค่าตามสมการที่ก้าหนดและใส่ค่าในฟิลด์ Area_Rai ดังภาพ 

 

 

 

 

 

 

 

 4.3.4  การวิเคราะห์ความลาดชัน ของพื้นท่ีลุ่มน้้า (Watershed) 

           ความลาดชัน (Slope) หมายถึง อัตราการสูงขึ้นหรือต่้าลงของภูมิประเทศ หรือหมายถึง

ความเอียงของพื้นผิวโลกที่ท้าให้เกิดขนาดมุมขึ้นกับพื้นระดับ หรือก็คืออัตราส่วนของความต่างใน

ระยะทางดิ่งระหว่างจุด 2 จุด (Vertical Distance  (กับระยะทางราบ ) Horizontal Distance) ระหว่างจุด 2 จุด

ที่พิจารณาซึ่งจะแสดงเป็นสมการดังนี ้                           

 

 

         ระยะในทางดิ่ง (Vertical Distance) คือ ความแตกต่างระหว่างความสูงของจุด 2 จุด ที่

พิจารณา จะหาความต่างระหว่างความสูงของจุด 2 จุด นี้ได้จากเส้นชั้นความสูงในแผนที่  

         ระยะในทางราบ (Horizontal Distance)  คือระยะทางระหว่างจุด 2  จุด ที่พิจารณา แล้วเทียบ

มาตราส่วนของแผนที่เพื่อหาระยะในภูมิประเทศ 
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        การวัดระยะทางเพื่อน้ามาค้านวณหาค่า Slope จากจุด B ไป A โดยแสดงในหน่วยเมตร 

(ก้าหนดมาตราส่วน 1:3,000)  สามารถท้าได้ 2 วิธีคือ (1) ใช้ไม้บรรทัด  (2)ใช้ เคร่ืองมือในเมนู ของ

โปรแกรม ArcGIS 

        (1) วิธีใช้ไม้บรรทัดในการวัดระยะทางจากจุด 2 จุด ดังรูปที่ 4.4 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.4 การพิจารณาความลาดชันระหว่างจุด A และ B ด้วยการวัดโดยตรง 

 

 

A 

B 
ระยะทางระหว่างจดุ B ถึงจุด A ท่ีวัดได้จาก

ไม้บรรทัดเท่ากับ 3.4 CM 
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   การพิจารณาหาระยะทางในทางดิ่ง (Vertical Distance) กระท้าได้โดยอาศัยดูจากเส้นชั้นความ

สูง (เส้น Contour) จากรูป 4.4 จะเห็นว่า ที่จุด A มีความสูง 45.6 และ จุด B มีความสูง 44.4 เมตร ก็จะ

สามารถหาความแตกต่างในทางดิ่งหรือระยะในทางดิ่งได้ โดยการเอาจุดที่สูงสุดต้ังและลบด้วยจุดที่ต่้าสุด 

คือ 45.6 เมตร ลบด้วย 44.4 เมตร ดังนั้นจะได้ ระยะในทางดิ่ง 45.6 - 44.4  =  1.2  เมตร  

 การพิจารณาหาระยะในทางราบระหว่างจุด B ถึงจุด A โดยอาศัยเทียบมาตราส่วน หาได้โดยการ

วัดระยะระหว่างจุด B ถึงจุด A กรณใีช้ไม้บรรทัดวัดหน่วยเป็นเซนติเมตรนั้นหากวัดได้เท่าไหร่ก็น้าไป

เทียบกับอัตราส่วนให้เป็นระยะในภูมิประเทศ จากภาพนี้สามารถวัดระยะระหว่างจุด B ถึงจุด A ค้านวณ

ได้จากสูตร 

 

 โดย   MD คือ ระยะในแผนที่ = 3.4 เซนติเมตร 

               GD คือ ระยะทางในภูมิประเทศ (เมตร) 

 

                                                   

                                                          

                                                                            เมตร 

เมื่อน้าไปเทียบกับมาตราส่วน 1:3,000 อ้างอิงค่าจากในโปรแกรม ArcMap ก็จะได้ระยะในทาง

ราบ เท่ากับ 102 เมตร 

เมื่อได้ระยะในทางดิ่งและระยะทางในทางราบแล้ว ก็น้ามาเข้าสูตรเพื่อหาค่า Slope  
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(2)  ใช้ เคร่ืองมือในเมนู ของโปรแกรม ArcGIS 

        การหาระยะทางจากจุด 2 จุด บนแผนที่ (Map) นั้น สามารถท้าได้โดยการคลิกที่ปุ่ม        

Measure จากนั้นก็น้าไปคลิกระหว่างจุดสองจุดในส่วนที่แสดงแผนที่ ก็จะมีรายงานระยะทางในแถบ

สถานะ (Status bar) ซึ่งอยู่ด้านล่างซ้ายมือ คือจะสามารถวัดระยะทางบนแผนที่ได้หลายแบบ เช่น จะวัด

ระยะทางเป็นเส้นทาง หรือวัดระยะโดยวาดเป็นรูปปิดหลายเหลี่ยม หรือวัดระยะส้าหรับฟีเจอร์ที่ต้องการ 

แต่ในที่นี้เราต้องการวัดระยะทางเป็นเส้นทาง ขั้นตอนการท้างานดังน้ี 

   -ให้คลิกเลือกที่ปุ่ม Measure         บนแถบเคร่ืองมือ Tools และก็จะปรากฏหน้าต่าง 

Measure ดังภาพ 

 

 

 

  - คลิกที่ปุ่ม Choose Unit เพื่อเลือกหน่วยที่ต้องการวัดระยะทาง เช่น ต้องการวัดระยะเป็น 

เมตร ก็ให้เลือก Distance เป็น Meters ดังภาพ 
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  -  คลิกที่ปุ่ม Measure line            จะปรากฏเคร่ืองมือวัดเป็นเคร่ืองหมายบวกของ Pointer         

          ก็ให้น้าไปคลิกที่ต้าแหน่งจุดที่ต้องการวัด 1 คร้ัง จากนั้นก็ให้ย้ายต้าแหน่งไปยังจุดที่ 2 ซึ่งใน map นี้

ก็คือให้คลิกเร่ิมต้นที่จุด B ไปยังจุด A และก็ให้ดับเบิ้ลคลิกที่จุดสุดท้าย เพื่อต้องการดูค่าความยาวที่ได้จาก

การวัด หรือก็คือ ค่าระยะห่างที่ได้จากจุด 2 จุด สามารถอ่านค่าที่วัดได้จากตรงที่หน้าต่างของ Measure 

โดยที่ Segment : คือ ค่าความยาวของเส้นล่าสุด และ Length : คือความยาวของเส้นทั้งหมด ซึ่งค่าของ 

Length นี้ก็คือ ค่าระยะทางที่วัดได้ ดังรูปที่ 4.5 

        

 

 

 

 

 

 

 

 

 

 

รูปท่ี 4.5 การพิจารณาความลาดชันระหว่างจุด A และ B ด้วยเคร่ืองมือของ ArcGIS 

 รายละเอียดของ  Tools บนหน้าต่างของ Measure ในเมนูของ ArcGIS มีดังนี้ 

  - 

A 

B 
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 หมายถึงใช้ในการวัดเส้น ดับเบิ้ลคลิกเมื่อต้องการสิ้นสุดการวัดเส้น 

     - 

  หมายถึงใช้ในการวัดพื้นที่ โดยดับเบิ้ลคลิกเพื่อต้องการสิ้นสุดขอบเขตการวัดพื้นที่ 

  -  

 หมายถึงคลิกลงบนแผนที่เพื่อท้าการวัดความยาว อาณาเขตบริเวณ หรือพิกัด X,Y เคร่ืองมือนี้ท้า

ให้ง่ายต่อการวัดแผนที่โดยไม่ต้องมีการลากเส้นบนแผนที่ 

  - 

 หมายถึงเปิดการใช้งานของเคร่ืองมือ snap วิธีการน้ีจะวิ่งหาเส้น หรือพื้นที่ตามจุดที่ใกล้ที่สุดโดย

อัตโนมัติตามระยะ Snap ที่ถกูก้าหนดมา คือ 8 Pixel เคร่ืองมือจะช่วยให้วัดระยะต่าง ๆ ได้แม่นย้ายิ่งขึ้น 

โดยที่ต้องกดปุ่ม Ctrl ค้างไว้ขณะที่ก้าลังท้าการลากเส้น ก็จะท้าให้เกิดการสแน๊ป ตลอดแนวเส้นที่จะเป็น

การวิ่งเข้าหาเฉพาะจุดเท่านั้น  

  - 

 หมายถึงเปิดการใช้งานเพื่อแสดงผลรวมของการวัดทั้งหมดที่ถูกท้ามาแล้ว  

  - 

 หมายถึงเลือกหน่วยของระยะทาง หรือหน่วยที่ใช้แสดงพื้นที่ 

  - 

 หมายถึงยกเลิกพร้อมกับลบข้อมูลการวัดที่ถูกท้ามาแล้วข้างต้น  

  เมื่อท้าการวัดได้ข้อมูลแล้วก็สามารถน้าค่าที่ได้นั้น ไปค้านวณหาค่า Slope อีกที โดยที่  

ใช้สมการในการค้านวณความลาดชันเช่นเดยีวกันกับวิธีแรก  


